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Chapter 1: Overview

About the ElectricAccelerator® Visual Studio
Integration

The ElectricAccelerator Visual Studio Integration is composed of two distinct converters and the
ecdevenv.exe utility:

« Visual Studio IDE Extension

This extension integrates with the Microsoft Visual Studio IDE and lets you build Visual Studio
solutions and projects using Electric Make® (eMake) from within the IDE. The extension
provides an Electric Cloud build menu and toolbar. The existing build menu remains intact for
local (non-eMake) builds.

This was implemented as a VSPackage starting with Visual Studio 2015 and as an add-in in
earlier versions of Visual Studio.

Visual Studio Converter Extension

This extension converts solutions and projects into NMAKE makefiles for eMake compatibility. It
is invoked for command-line builds and ecdevenv.exe.

This was implemented as a VSPackage starting with Visual Studio 2015 and as an add-in in
earlier versions of Visual Studio.

ecdevenv.exe Utility

ecdevenv is a drop-in replacement for devenv.exe that builds Visual Studio solutions and
projects using eMake. It provides a number of important features. See Using the ecdevenv
Utility on page 7-1 for information. ecdevenv.exe is invoked by the Visual Studio IDE extension
to perform eMake builds.

The ElectricAccelerator Visual Studio Integration is installed automatically during the installation of
ElectricAccelerator.







Chapter 2: What's New

New Features and Functionality in Version 5.2.5
The installers for the Visual Studio Extension 5.2.5 and for ElectricAccelerator 10.1 are enhanced to let
you automatically initialize Visual Studio on agent hosts:

« Inthe Visual Studio Extension installer, the Initialize Visual Studio for
ECloudInternalUsers checkbox is added to the Select Visual Studio Version screen. (VSP-

1167)

« Inthe ElectricAccelerator installer, the Initialize Visual Studio for ECloudInternalUsers
checkbox is added to the Configuring the Electric Agent screen. (EC-12802)

Resolved Issues in Version 5.2.5

Visual Studio Converter Extension

« Anissue is fixed in which MSBuild did not create certain required directories (such as for logging)
if the build used build customizations. This issue caused the following error message: error
MSB3491: Could not write lines to file <file>. (VSP-1159)

Installer

« Because of a known issue, the ability to upgrade the Visual Studio Integration on all Windows
agent hosts that are registered to the Cluster Manager that you specify is removed. This means
that the installer now performs only local installations, and therefore, the Setup Type dialog
box is removed. (VSP-1166)

Resolved Issues in Version 5.2.4

Visual Studio IDE Extension

. The Max Local Agents field in the Advanced tab of the Solution Settings window is now
disabled (regardless of whether it was previously set) if the installed eMake version is 9.1 or later.
(VSP-1134)

Visual Studio Converter Extension
« Usingthe /FU compiler option no longer produces duplicate assemblies. (VSP-1151)

« Theissue where environment variables in response files were not expanded is fixed. (VSP-1133)

New Features and Functionality in Version 5.2.3

Visual Studio Converter Extension




2' 2 ElectricAccelerator Visual Studio Integration 5.2.5

« To improve MSBuild build times for unparseable projects (such as those containing Build
Customizations), the extension now passes the MSBuild /m switch (without a value) to MSBuild so
that all cores are used by default. (VSP-1132)

Resolved Issues in Version 5.2.3

Visual Studio IDE Extension

« The setting for the MSBuild project build output verbosity level is now passed to add-in based
builds so that they show the same level of verbosity as Visual Studio. (VSP-1131)

« For Accelerator 9.1 and later versions, you can no longer simultaneously use local agents and a
cluster manager. This means that the Use Local Agents check box in the General > Cluster
tab of the Solution Settings window has no effect when you specify a cluster manager using
the Cluster Manager field in the General > Basic tab. This also means that simultaneously
using the --emake-localagents eMake option and the --emake-cm eMake option from the
command line produces an error. (VSP-1130)

Visual Studio Converter Extension

« The extension now turns off parsing for projects with more-complex Build Customizations and
instead uses MSBuild. This avoids the fatal error C1083: Cannot open include file:
'<filename>.h': No such file or directory error because eMake could not locate the

header file. (VSP-1129)

New Features and Functionality in Version 5.2.2

Visual Studio Converter Extension

« (Visual Studio 2010 and newer versions) The ECADDIN USE MSBUILD FOR LINK environment
variable and the UseMSBuildForLink configuration file variable are introduced. When these
variables are enabled, the extension uses MSBuild for linking. These variables are a workaround
for an issue in which VCManifestTool is not supported in Visual Studio 2015 and newer versions
and might not be supported in Visual Studio 2010-2013.

These variables are enabled by default for Visual Studio 2015 and newer versions and disabled by
default for Visual Studio 2010-2013. (VSP-1118)

Resolved Issues in Version 5.2.2

Visual Studio IDE Extension

« Theissue where the Electric Cloud > Debug Project menu option is unresponsive on some
Visual Studio versions is fixed. (VSP-1124)

Visual Studio Converter Extension

« The following NMAKE error no longer occurs when you import more than one library and up-to-
date-check is enabled: fatal error U1000: syntax error : ')' missing in macro
invocation. (VSP-1122)

New Features and Functionality in Version 5.2.1

Visual Studio 2017 Community and Enterprise Edition Support

Chapter 2: What's New
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« Support is added for the Community and Enterprise editions of Visual Studio 2017. The
integration is installed for all editions. (VSP-1110)

Visual Studio Converter Extension

« Support is added for Visual Studio build customizations. If you encounter issues with a project
when using this feature, you can disable it for all projects containing Build Customizations by
setting ECADDIN PARSE BUILD CUSTOMIZATIONS or ParseBuildCustomizations to FALSE or by
disabling parsing for only that project by setting ECADDIN DONT PARSE PROJECT Of
DoNotParseSpecificProjects to TRUE. (VSP-1071)

Resolved Issues in Version 5.2.1

Visual Studio Converter Extension

o Fixedan NMAKE: fatal error U1073: don't know how to make '"<file>"' errorthat
occurred when a project contained a source file whose path used a macro. (VSP-1121)

« The LINK : fatal error LNK1146: no argument specified with option
' /MANIFESTFILE: ' error no longer appears. (VSP-1116)

« The converter extension no longer assumes a Visual Studio DPI Awareness setting of None. All
Visual Studio DPI Awareness settings are now recognized. (VSP-760)

New Features and Functionality in Version 5.2

Visual Studio Converter Extension

« Support is added for Visual Studio Professional 2017. For details, see
https://docs.microsoft.com/en-us/cpp/what-s-new-for-visual-cpp-in-visual-studio. Note that
the /PERMISSIVE switch is not supported in the Visual Studio IDE. (VSP-1109 and VSP-1090)

« Support for Visual Studio 2005 is reintroduced. (VSP-1106)
« The ECADDIN LINK PARAMETERS environment variable and the LinkParameters configuration file
variable are introduced. These variables add options to the linker command. For example,

ECADDIN_LINK_PARAMETERS=/OPT :REF Or LinkParameters=/INCREMENTAL /NOLOGO /DEBUG
/PDB:a.pdb. (VSP-1102)

. The ECADDIN NORECURSE environment variable and the NoRecurse configuration file variable are
introduced. When these variables are enabled, only the specified project configurations are built,
and dependent projects in those configurations are ignored. (VSP-1101)

. The ECADDIN NOLINK environment variable and the NoLink configuration file variable are
introduced. When these variables are enabled, all build steps are performed except linking and
post-build steps. (VSP-1100)

Resolved Issues in Version 5.2

Visual Studio Converter Extension

« Aclean dependency is added for rebuilds (not builds) to improve build speed. (VSP-1096)

ecdevenv Utility

Resolved Issues in Version 5.2.1
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« Theissue where selective project regeneration failed because ecdevenv did not use the correct
project name when the projects had relative paths is fixed. (VSP-1103)
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Chapter 3: Known Issues

« If up-to-date check is enabled, custom build steps do not rebuild if the output is missing.
« Order-only prerequisites are turned off automatically when up-to-date check is enabled.

« Ifthe cluster upgrade option of the VS IDE Converter installer fails, re-run the installer to ensure
the VS Converter is installed correctly.

« Because of an issue with previous versions’ uninstallers, an upgrade might cause the following
error message: Cannot find script file: C:\ECloud\i686 win32\bin\unregaddin.vbs.
You can ignore this message.

« Make sure you finish all Visual Studio installations before installing the VS IDE Integration.
Adding a new language to an existing Visual Studio installation with the VS IDE Integration
already installed causes Visual Studio to display an empty Electric Cloud menu. The workaround
is to reinstall the integration.

« Visual Studio 2008 builds might break or might not be optimized after you upgrade from an
earlier version. For instructions to work around this issue, see the knowledge base article KBEA-
00065, The build breaks after upgrading to Visual Studio 2008.

« In Microsoft Visual C++ 2010 and later, projects that contain custom build rules are not
parallelized at the project item level.

« LightSwitch projects are not supported.
« UWP projects are not supported.

« For Visual Studio 2010 and later, the MSBuild item metadata syntax is not supported for C++
build events (pre-build, pre-link, and post-build events). The workaround is to substitute the
variables with actual values or use ECADDIN DONT PARSE PROJECT to build the project with
MSBuild.



https://electriccloud.zendesk.com/entries/105076-KBEA-00065-The-build-breaks-after-upgrading-to-Visual-Studio-2008
https://electriccloud.zendesk.com/entries/105076-KBEA-00065-The-build-breaks-after-upgrading-to-Visual-Studio-2008




Chapter 4: System Requirements

Supported Visual Studio Versions

The Visual Studio IDE Integration supports the following versions of Visual Studio:

Visual Studio 2017 (all editions)
Visual Studio 2015
Visual Studio 2013
Visual Studio 2012
Visual Studio 2010
Visual Studio 2008
Visual Studio 2005

Prerequisites

MSBuild Prerequisites

The IDE converter cannot virtualize the MSBuild utility. If you are virtualizing your toolchain, you might
need to install the following packages for your version of Visual Studio on every agent host in your

cluster.
Visual Studio Version Packages
« .NET Framework 4.6.2
2017 « MSBuild Tools 15.0
« Visual C++ Build Tools 15.0
« .NET Framework 4.6
2015
« Microsoft Build Tools 2015
« .NET Framework 4.5
2013
« Microsoft Build Tools 2013
2012 .NET Framework 4.0.30319
2010 .NET Framework 4.0.30319
2008 .NET Framework 3.5
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Visual Studio Version Packages

2005 .NET Framework 2.0.50727

If you do not virtualize your toolchain, you must install Visual Studio on each agent host in your cluster.

VS IDE Extension Prerequisites
The VS IDE Extension requires:

« eMake installed on the build machine

« .NET Framework v2.0

VS Converter Extension Prerequisites
The VS Converter Extension requires:
« Microsoft Visual C++ 2010 Redistributable Package
o .NET Framework v2.0

« (Ifusing Visual Studio 2005 Service Pack 1) Microsoft hotfix that is described in Microsoft
Knowledge Base articles 933054 and 934517. Without the hotfix, the VS Converter Add-In will
not function correctly, which means that ecdevenv is not called, so builds will not be accelerated.

For download information, see the Visual Studio 2005 behaves as if the Visual Studio Add-in is
not installed article on the Electric Cloud “Ask” website at http://ask.electric-cloud.com.

ecdevenv Utility Prerequisites
The ecdevenv utility requires:
« VS Converter Extension
« Microsoft Visual C++ 2005 SP1 Redistributable Package

o« .NET Framework v2.0

Upgrade Notes

Electric Cloud recommends regenerating the history file after upgrading the VS Integration.

Chapter 4: System Requirements
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Chapter 5: Installing the IDE Integration

Installing the Integration Using the GUI

To install the VS IDE integration using the installation wizard:

1.

Right-click the vsIintegration-<version>-Install.exe file and choose Run as
administrator.

When the ElectricAccelerator VS Integration Setup screen appears, click Next.

When the Choose Destination Location screen appears, click Next to accept the default
installation location (c:\EC1loud) or click Browse to change the location and then click Next.

When the Select Visual Studio Version screen appears, make the following selections and
then click Next:

. Installed versions—Choose specific Visual Studio versions where you want the
converter to be installed.

By default, all the Visual Studio versions are selected.

« Initialize Visual Studio for ECloudInternalUsers—If you do not virtualize the
toolchain, you must use this option, which initializes Visual Studio on every agent host for
each ECloudInternalUser.

Each Accelerator agent runs as user ECloudInternalUserl, ECloudInternalUser2, and so
on.

When the Installing screen appears, you can view the progress of the installation.

When the ElectricAccelerator VS Integration Setup screen displays ElectricAccelerator
VS Integration Wizard Complete, your installation is complete. Click Finish to close the
installer.

The installation log file is in the installation directory’s root, c: \ECloud by default.

Installing the Integration Silently

To perform a silent installation, follow these steps:

1.

For the first installation, run the installation with the /save-response-file <filename> option
and your desired settings.

This creates the response file in the directory where you ran the installer.

For subsequent silent identical installations, use the resulting response file by using the
/response-file <filename>and /mode silent options.

The syntax for silent installation is:

VSIntegration-<version>-Install.exe [<options>]
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Option Description

/mode <install mode>

Installation mode. Available values are standard (default)
Oor silent.

/prefix <directory>

Installation directory.

/response-file <response
input file>

File from which to read installer responses.

/save-response-file
<response output file>

File to which installer responses are written when the
installer exits.

/temp <temp dir>

Temporary directory used by the installer.

/version

Displays installer version information.

/vsinit <0|1>

Initializes Visual Studio on every agent host for each
ECloudInternalUser. You must use this option if you do not
virtualize the toolchain. Each Accelerator agent runs as
user ECloudInternalUserl, ECloudInternalUser2, and so
on.

The default is 0 (do not initialize).

/vsversions <versionl> [,
<version2> ...]

Installs the converter for a comma-separated list of Visual
Studio versions. Available values are 2005, 2008, 2010,
2012,2013,2015,and 2017.

Chapter 5: Installing the IDE Integration




Chapter 6: Using the VS IDE Extension
Interface

When the VS IDE Extension starts, it checks if the following are present:

« eMake— If the converter cannot find eMake, the converter's Build, Rebuild, and Clean functions
are disabled.

When eMake is run from Visual Studio, it must be run through an intermediate application
named ecspawn.exe. This program ensures that eMake responds correctly to ctr1-c and that
child processes are grouped together. This application is displayed in the Task Manager. Do not
terminate the application; it stops when the build finishes or when the build is canceled.

Do not run local (non-eMake) builds while running eMake builds and vice-versa.

« ElectricInsight®—If the converter cannot find Insight, the converter's Run ElectricInsight
function is disabled.

Topics:

« Main Menu and Toolbar on page 6-2

o Solution Settings on page 6-8
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Main Menu and Toolbar

When you run Visual Studio, you are presented with the Electric Cloud main menu and toolbar:

E

Electric Cloud | Debug Team Data Tools T
Build Solution
Rebuild Selution

L3
i

m_wX kPR GE

Clean Solution
Intrinsic.cpp
Build Intrinsic

. L. (Global 5c
Rebuild Intrinsic
oject) B/ Int
Clean Intrinsic H
ENCIES Cancel
#incluy
Run ElectricInsight
Settings
Help * | @ Help
& About

The menu has the following functions:
« Build Solution—Builds the current solution

« Build Solution Locally—Builds the current solution locally with eMake but without using
remote agents or local agents (this function is equivalent to turning off the Cluster Manager and
local agents). This function is hidden by default. See Build Solution Locally on page 6-3 for
additional information about this function.

« Rebuild Solution—Rebuilds the current solution

« Clean Solution—Cleans the current solution

« Build <project>—Builds the current project or selection

« Rebuild <project>—Rebuilds the current project or selection
« Clean <project>—Cleans the project or selection

« Cancel—Cancels a running eMake build. When a build is running, you can cancel it by selecting
Cancel. Cancel is available only during a running build, rebuild, or clean.

Chapter 6: Using the VS IDE Extension Interface
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« Run ElectricInsight—Runs Insight with the current annotation file (if it exists). At any time,
you might run ElectricInsight (Insight) to view the annotation file. Insight loads the specified
annotation file or defaults to emake.xml.

When you run Insight from Visual Studio, Visual Studio looks for the currently running instance
of einsight. If einsight is currently running, the annotation file is not loaded (or reloaded).
Manually open the annotation file from Insight, or close Insight and select Run ElectricInsight
again.

On 64-bit systems, this menu option invokes the 64-bit version of ElectricInsight. For details
about the 64-bit and 32-bit versions of ElectricInsight, see the “Installing ElectricInsight”
chapterin the ElectricInsight User Guide at http://docs.electric-cloud.com/accelerator_
doc/AcceleratorIndex.html.

« Settings—Opens the solution settings dialog box
« Help submenu

« Help—Display help resources
« About—Displays information about the current extension installed

When selecting one of the build commands, the converter calls ecdevenv.exe to perform the build.

The project and configuration are taken from the current context. The command is dependent on the
menu item.

The toolbar provides the same functionality as the Electric Cloud main menu and is customizable.

LA EL R ANT =

Build Solution Locally

You can build a solution locally with eMake but without using remote agents or local agents. You might
want to use this function if a distributed incremental build is slow, or if a local Visual Studio incremental
build causes unnecessary rebuilding of objects. To make this function visible in the menu, set the
environment variable ECUIADDIN LOCAL BUILD=true.

The following screenshot illustrates the menu with the Build Solution Locally function.

Main Menu and Toolbar
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ElectricCloud | Tools Test Analyze

[zl  Build Solution
[zl  Build Solution Locally
% Rebuild Solution
|_# Clean Solution
|%] Build ConsoleApplicationl
8 Rebuild ConsoleApplicationl
| Clean ConsoleApplicationl
2 Cancel
% Run ElectricInsight
= Settings...
Help

-

Advisories for Build Solution Locally

« The eMake local build does not support the eMake eDepend feature (also called Auto Depend).
This means changes in header files might not cause dependent source files to be recompiled.

« The eMake local build does not produce an annotation.

« Because history is not generated, unexpected conflicts might occur on subsequent eMake

cluster builds.

Output Pane

Output from an eMake build is displayed in the EC Build output pane (displayed in the following

screenshot).

Chapter 6: Using the VS IDE Extension Interf




Output ~ B X
Show output from: | EC Build 412 Qe ==
skipped regeneration of nmake makefiles. -

Total conversion time: eemees
Starting build: local-18828
emake -§ "C:\Users\charvey\Documents\Visual Studio 2018\Projects\VS_Project\WindowsApplicationl.sln.Debug Mixed_Plato
------ Rebuild All started: Project: Class Library, Configuration: Debug Any CPU ------
Microsoft (R) Build Engine version 4.€.3@319.18408
[Microsoft .MET Framework, version 4.9.36319.18444)
Copyright (C) Microsoft Corporation. All rights reserved.
Build started 18/6/2014 12:55:41 PM.
Project "C:\Users\charvey\Documents\Visual Studio 2@1@\Projects\VS_Project\Chris Class Library\Class Library.csproj” on nos
CoreClean:
Deleting file "C:\Users\charvey\Documents\Visual Studio 201@\Projects\VS_Project\Chris Class Library\bin\Debug\Chris Cla:
Deleting file "C:\Users\charvey\Documents\Visual Studio 2018\Projects\VS_Project\Chris Class Library\bin\Debug\Chris Cla:
Deleting file “"C:\Users\charvey\Documents\Visual Studio 2818\Projects\VS_Project\Chris Class Library\obj\Debug\Chris Cla:
Deleting file "C:\Users\charvey\Documents\Visual Studio 201@\Projects\VS_Preoject\Chris Class Library\obj\Debug\Chris Cla:
CoreCompile:
C:\Windows\Microsoft.NET\Framework\v4.@.30319\(sc.exe /noconfig /nowarn:17@1,1782 /nostdlib+ /errorreport:prompt /warn:d
CopyFilesToOutputDirectory:
Copying file from “obj\Debug\Chris Class Library.dll™ to "bin\Debug\Chris Class Library.dll".
Class Library -> C:\Users\charvey\Documents\Visual Studio 2@1@\Projects\VvS_Project\Chris Class Library\bin\Debug\Chris C.
Copying file from "obj\Debug\Chris Class Library.pdb" to "bin\Debug\Chris Class Library.pdb".
Done Building Project "C:\Users\charvey\Documents\Visual Studio 201@\Projects\VS_Project\Chris Class Library\Clasc Library
Build succeeded.
@ Warning(s)
@ Error(s)
Time Elapsed ©0:00:00.36
—————— Rebuild All started: Project: VisualBasicProject, Configuration: Debug x86 ------
Microsoft (R) Build Engine version 4.9.38319.18488
[Microsoft .MET Framework, version 4.9.36319.18444)
Copyright (C) Microsoft Corporation. All rights reserved.
« [Lm
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Context-Sensitive Menus

The converter provides additional context-sensitive menus. The following screenshot illustrates the

Solution menu.

Main Menu and Toolbar
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Bl el 1o ‘ConscleApplication]’ (1 project)

config

Build Solution Ctrl+Shift+B onsoleApplicationl
Rebuild Solution References
Gleansaltion ? External [_Jependencies
 ne
Electric Cloud [zl Build Solution
Batch Build... 'K Rebuild Solution
Configuration Manager... |_f Clean Solution
Manage NuGet Packages for Solution... = Settings..
Restore NuGet Packages L# ReadMe.bet
New Solution Explorer View
Calculate Code Metrics
Retarget solution
Add
Set StartUp Projects... ' 3sllelI@ Team Explorer Class View
Add Solution to Source Control...
Paste Ctrl+\ pplicationl Solution Properties
Rename }'
Open Folder in File Explorer
ConsoleAppli
Properties Alt+Enter Debug|x86 ﬂw

The following screenshot illustrates the Project menu.
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VisualBasicP

[=d My Proje Build
Forml.vi Rebuild
i Win32 App Clean
% E::;”ETF Electric Cloud * | ] Build VisualBasicProject
] stdaf [ Publish.. % Rebuild VisualBasicProject
[n] targe Project Dependencies... _F Clean VisualBasicProject
(L Resourc A
[Z Source F
&Y stdaff D :
'?_‘3 Win3 Add Reference...
u ReadMe Add Service Reference...
& View Class Diagram
Set as StartUp Project
Debug r
ﬁ Add Solution to Source Contral...
# Cut Ctrl+X
[ Paste Chrl+V
)( Remove Del
Rename
Unload Project
Rescan Sclution
ﬁ Open Folder in Windows Explorer
(= Properties Alt+Enter

The following screenshot illustrates the Selection menu.

r; Solution "WindowsApplicationl' (3 projects) I]
B |@ Class Likrarn:!
B | -._E YisualB Build Selection

b L;.’:I Win32 Rebuild Selection

Clean Selection

Electric Cloud * | ] Build Selection
Project Dependencies... % Rebuild Selection
Project Build Order... . Clean Selection

Add Solution to Source Control...

Cut Ctrl+X
Copy Ctrl+C

X i o= Qg

Remove Del

Unload Project

Rescan Solution

il

Properties Alt+Enter

Main Menu and Toolbar
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Solution Settings

The Solution settings dialog box contains the following Solution Settings categories:

General Solution Settings on page 6-8
ElectricInsight Solution Settings on page 6-14
Options Solution Settings on page 6-16
Debug Solution Settings on page 6-18
Advanced Solution Settings on page 6-21

Command Line Solution Settings on page 6-23

General Solution Settings

This category contains most frequently used settings:

Basic Solution Settings on page 6-8

Cluster Solution Settings on page 6-10
History Solution Settings on page 6-10
Performance Solution Settings on page 6-11

Annotation Solution Settings on page 6-13

Basic Solution Settings

The following screenshot illustrates the Basic subcategory.
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& History
i Performance
.. Annotation

- ElectricInsight

- Options

[+-Debug

- Advanced

- Command Line

Cluster Manager

Root

Add Emake Roots Automaticaly

Reject changes

Macros | [

0K

J [ cancel

. Cluster Manager—Indicates the eMake Cluster Manager (--emake-cm).

ElectricAccelerator Visual Studio Extension 5.2.5 6'9

If this field is empty, an eMake build is performed with local agents when Use Local Agents is
selected. When Use Local Agents is not selected, a local eMake build (without remote or local
agents) is performed.

For Accelerator 9.1 and later versions, you cannot simultaneously use local agents and a cluster
manager. If you specify a cluster manager in this field, the setting for the Use Local Agents
checkbox is ignored.

« Root—Specifies the eMake root (--emake-root). To add a path to the eMake root manually,
enter a path or click the folder button to browse and then click the plus button to add it to the
list. To delete a path from the eMake root manually, select it in the list and click the x button.

« Add Emake Roots Automatically—Adds the locations of all inputs (such as .cpp and .h files)
and outputs (such as .obj, .exe, and .dll files) to the eMake root automatically.

This checkbox applies only to C++ projects. If you have a C# project or a project with inputs and
outputs not in the solution or project locations, you must add their locations to the eMake root

manually.

This checkbox does not apply to third-party tools, because they cannot be virtualized. This
checkbox does not apply to project locations and each location for the solution(s), because they
are always added automatically.

Solution Settings
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Cluster Solution Settings

The following screenshot illustrates the Cluster subcategory.

[=-General Build Label

History Build Class
Performance
Annotation

- ElectricInsight Resource
- Options
[+-Debug
- Advanced [¥] Virtualize Toolchain

- Command Line Use 64-bit emake
[¥] Use Local Agents

Reject changes Macros |[ oK ][ Cancel

« Build Label—Specifies the build label (--emake-build-label).
« Build Class—Specifies the build class (--emake-class).
« Resource—Specifies the build resource (--emake-resource).

« Virtualize Toolchain—Determines whether to virtualize the Visual Studio toolchain. This
checkbox is checked by default.

« Use 64-bit eMake—Determines whether to use the 64-bit version of eMake. This checkbox is
unchecked by default.

« Use Local Agents—Determines whether to use local agents (--emake-localagents). This
checkbox is checked by default.

History Solution Settings

The following screenshot illustrates the History subcategory.
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[=-General History File
i Basic =
Cluster
REET History
«- Performance
... Annotation () Create
- ElectricInsight
- Options @ Merge
- Debug _—
- Advanced ©

- Command Line

Set history to merge (--emake-create=merge) Macros ] [ oK ” Cancel

« History File—Specifies the history file to use (--emake-historyfile). The default is
eMake.data.

ator Visual Studio Extension 5.2.5 6' 1 1

« History—Specifies the eMake history option (--emake-history). Available values: Create,

Merge, or Read.

Performance Solution Settings

The following screenshot illustrates the Performance subcategory.

Solution Settings
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Solution Settings
= General Maximum PDB files
.. Basic =
16
Cluster E
History Use Order-Only Prerequisites
Always Rescan Solution
. Annotation
- ElectricInsight Enable Incremental Link
- Options Remove Dependencies
[+-Debug

F iRistiad Set Debug Information Format to C7 Compatible
- Command Line Up To Date Check

Run Local Link

Coarse Grain Paralielization
Local Clean

Reject changes Macros | |L. 0K ” Cancel

« Maximum PDB Files—Sets the maximum number of PDB files used when splitting (sets
ECADDIN MAX PDB FILES). The defaultis 16. If you have fewer than 16 agents, you can
decrease this value to be equal to or less than the number of agents. This setting has no effect if
you enable Set Debug Information Format to C7 Compatible, which adds debugging
information to the object files.

« Use Order-Only Prerequisites—Determines whether to use order-only prerequisites (sets
ECADDIN USE ORDER ONLY PREREQS=true if enabled). Using order-only prerequisites can
improve first-time build speed.

« Always Rescan Solution—Determines whether to always recreate temporary makefiles even
if the solution has not changed.

. Enable Incremental Link—Enables or disables incremental linking (sets ECADDIN ENABLE
INCREMENTAL LINK=true if enabled).

« Remove Dependencies—Determines whether to remove dependencies and references (sets
ECADDIN REMOVE DEPENDENCIES=true if enabled). Removing dependencies prevents Visual
Studio from building dependent projects.

« Set Debug Information to C7 Compatible—Determines whether to force compiler option
/Z7 (sets ECADDIN FORCE z7). Note that enabling this setting typically creates larger executable
files. This setting adds debugging information to the object files and thus overrides Maximum
PDB Files.

0000000000000
Chapter 6: Using the VS IDE Extension Interface
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. Up To Date Check—Determines whether to check if anything requires building (sets ECADDIN
UP_TO DATE CHECK=true if enabled).

« Run Local Link—Links specified projects locally using #pragma runlocal (sets ECADDIN RUN
LOCAL_LINK). Use the projects button to select projects.

. Coarse Grain Parallelization—Converts the solution to NMAKE more quickly by parallelizing
down to the project level only. It does not require Visual Studio to be installed. Using this option
is equivalent to using the ecdevenv /quick option.

« Local Clean—Runs clean locally rather than on the cluster. This makes the clean faster and
avoids conflicts in a rebuild.

Annotation Solution Settings

The following screenshot illustrates the Annotation subcategory.

=- G_EFIE'I'E| Annotation Detail
i Basic
Cluster Basic Lookup
History ] ]
[ [
oo Environment Registry
File Waiting
- ElectricInsight i
- Options History
[+-Debug

- Advanced E

- Command Line

Annotation File

Annotation Upload

Set history to merge (--emake-create=merge) Macros | l oK I ’ Cancel

. Annotation Detail—Specifies the level of annotation detail (--emake-annodetail) from the
following selections:

« Basic—Collects information about every command run by the build. Detailed information
about each “job” in the build is recorded, including command arguments, output, exit code,
timing, and source location. In addition, the build structure is represented as a tree where
each recursive make level is represented in the XML output. This checkbox is checked by
default.

Solution Settings



« Environment—Adds information about environment variable modifications.
. File—Adds information about files read or written by each job.

« History—Adds information about missing serializations discovered by eMake. This includes
information about which file caused two jobs to become serialized by the eMake history
mechanism.

. Lookup—Adds information about files that were looked up by each job.

« Registry—Adds information about registry operations.
. Waiting—Adds information about the complete dependency graph for the build.

« Annotation File—Specifies the annotation file (--emake-annofile). Required if annotation
detail is set. Use the folder button to select a file.

« Annotation Upload—Determines whether to upload the annotation file to the Cluster Manager
(--emake-annoupload).

Starting build: <build number>

ERROR EC1007: Unknown annotation detail token: "none"

Valid tokens are: 'basic', 'env', 'file', 'history', 'lookup', 'md5"',
'registry', 'waiting'

To avoid this error, you must upgrade the agents to Accelerator 8.1 or newer or check at least
one Annotation Detail checkbox.

ElectricInsight Solution Settings

This category contains settings for using ElectricInsight from within Visual Studio to monitor build
progress. Build monitoring is disabled for non-accelerated builds. This feature requires ElectricInsight
version 5.2 or newer.

Chapter 6: Using the VS IDE Extension In
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« Monitor Build—Launches ElectricInsight when a build starts. This setting is enabled by default.

« Host—Host name or IP address of the ElectricInsight machine where the build will be monitored
(hostname in ——emake-monitor=<hostname or IP address>:<port>).Ifthisis left blank, the

current host (the local host) is used.

« Port—Port for ElectricInsight monitoring (IP_addressin --emake-monitor=<hostname or IP
address>: <port>. If this is left blank, the port is selected automatically (to prevent conflicts
among devenv instances when multiple instances of Visual Studio or ElectricInsight are
running). An automatically-selected port numberis 2710 + the process ID of the executing
devenv process.

Solution Settings
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. Integrate into IDE—Docks or undocks ElectricInsight. When this setting is checked,
ElectricInsight appears in a Visual Studio tool window rather in its standard user interface
outside of Visual Studio. When ElectricInsight is docked, the file menu, toolbar, summary pane,
and file name are hidden:

:_‘ BabyGrid.cpp + X ~ | Solut|
i % Notepad++ < (Global Scope) - M |-
B S /BABYGRID code is copyrighted (C) 20082 by David Hillard [+
i " N Sear
; //This code must retain this copyright message P
9 '
g //Printed BABYGRID message reference and tutorial available.
= 7//Email: mudcat@mis.net for more information.
El/*
Add WM_MOUSEWHEEL, WM_LBUTTONDBLCLK and WM_RBUTTONUP events
Modified by Don HO <don.h@free.fr>
=/
Electric Insight *[AXx
Agents & Jobs
M2800-CFULMER 1| [ [ ea] [ [weea] [ =en] [ ]I
2 [ [ [re et oot [T ] |
s T T Tl T
¢ M T TTereesileee] T TTT ]
5 [[ouerenr] m]] [=epi0-ai] T T T 1
6 [CTTT Teesl =T TTTTTT
G ) 11 === Solu
8 [ [wewr[caenleneer [T Towes [ T |l
R R T T A R T T R S e R T A S T S R S R S R A S R A R S S R R A S B A A R N B AN IR TR
o ‘ —
Mavigation ==
1 »
Finished loading (15ms) 20.0 pps
Output > I X
Show output from: | Electric Cloud Build - ‘ < | R = | = ‘ *a
Searching C:\Program Files (x86)\Microsoft SDKs\Windows\v7.1A\lib\oleaut32.1ib: a
Saarching (- Lilac (vREN\Mirpncaft SHKC\Hindowg AANTihNdid Jik:

Options Solution Settings

This category contains most frequently used optional settings.

Chapter 6: Using the VS IDE Extension Interface
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Solution Settings &u

=~ ngeral Do Mot Parse Projects
- Basic Run Deployment Locally
i Cluster —
Continue On Error
i History
- Performance Keep Going
- Annotation Use Devenv for All Projects
Lge Deveny for Unparsed Projects
[+- Debug
.. Advanced Use Devenv for Spedfied Projects
- Command Line

Serialize All Projects
Do Mot Parse Spedific Projects

Fun Local Project

Expand Linker Objects
Lge Solution In MsBuild Projects
|Use Solution For Specified MsBuild Projects

Reject changes Macros |l oK ” Cancel ]

. Do Not Parse Projects—Determines whether to prevent the VS Converter from breaking up
C++ projects (sets ECADDIN DONT PARSE PROJECTS=true if enabled).

« Run Deployment Locally—Determines whether to run deployment projects locally using
#pragma runlocal (Sets ECADDIN RUN DEPLOYMENT PROJECTS LOCALLY=true if enabled).

« Continue On Error—Determines whether to ignore errors that occur during the build (adds /1
to the call to eMake).

. Keep Going—Determines whether to keep going when an error occurs during the build (adds
/% to the call to eMake).

« Use Devenv for All Projects—Determines whether to run all projects using devenv, not
MSBuild (sets ECADDIN USE_DEVENV=true if enabled).

« Use Devenv for Unparsed Projects—Determines whether to use devenv for unparsed
projects (sets ECADDIN USE MSBUILD=true).

. Use Devenv for Specified Projects—Run specified projects using devenv, not MSBuild (sets
ECADDIN USE DEVENV_FOR PROJECTS). You can either type in the project names (separated by
semicolons and without quotes or white spaces) or click the corresponding button to browse for
projects.

Solution Settings
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« Serialize All Projects—Determines whether to serialize all projects using #serialize (sets
ECADDIN SERIALIZE=true if enabled).

. Do Not Parse Specific Projects—Prevents the VS Converter from breaking up specified C++
projects (sets ECADDIN DONT PARSE PROJECT). You can either type in the project names
(separated by semicolons and without quotes or white spaces) or click the corresponding button
to browse for projects.

This variable is useful for deploying the converter. If, for any reason, the converter cannot build
some of your projects, this variable lets you work around the problem.

« Run Local Project—Runs specified projects locally using #pragma runlocal (sets ECADDIN
RUN LOCAL_ PROJECT). You can either type in the project names (separated by semicolons and
without quotes or white spaces) or click the corresponding button to browse for projects.

Use this variable if your build uses a local resource (for example, a resource only on the eMake
host such as a database). You do not need to set this variable if your project build includes web
deployment; this is handled by the converter. Each project name must be the unique Visual
Studio identifier for the project (for example, solutionl/projectl.vcproj).

. Expand Linker Objects—Determines whether to expand linker objects to full path names
(sets ECADDIN EXPAND LINKER OBJECTS=true if enabled).

« Use Solution In MsBuild Projects—Modifies the call to MSBuild to build a project within the
solution context (sets ECADDIN BUILD PROJECTS IN SOLUTION CONTEXT=true if enabled). This
option overrides the Use Solution For Specified MsBuild Projects option. This option is
needed for unparsed projects (such as C# projects or unparsed C++ projects).

« Use Solution For Specified MsBuild Projects—Maodifies the call to MSBuild to build specific
projects within the solution context (sets ECADDIN BUILD SPECIFIC PROJECTS IN SOLUTION
CONTEXT accordingly). This option is needed for unparsed projects (such as C# projects or
unparsed C++ projects). You can either type in the project names (separated by semicolons and
without quotes or white spaces) or click the corresponding button to browse for projects.

Debug Solution Settings

This category contains debug options for the Debug Solution Settings on page 6-18 and eMake Solution
Settings on page 6-21.

Chapter 6: Using the VS IDE Extension Interface
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Converter Solution Settings

Solution Settings W TR Tk TR RN W W s

= General Enable Debug Log
I BTS‘C Debug Log Name
- Cluster
- History @
- Performance | [| Do Not Delete Temp Makefiles
[;""t‘?‘””"tatio“ [] Do Not Use Unique Names
- Options )
=1-Debug Disable Converter
Enable ECBreakpoint
-~ Emake Enable ECBreakpoint for Spedfic Projects
- Advanced
- Command Line
||
OEERpLEahn s | Macros | ook ] [ Cancel

- Enable Debug Log—Determines whether to enable debug logging (sets ECADDIN DEBUG=true
if enabled).

- Debug Log Name—Specifies the name of the debug log (sets ECADDIN DEBUG LOG_FILENAME).
The default location is $TMP%\ecdebug<unique>.log (Where $TMP% is usually
C:\Users\<username>\BAppData\Local\Temp). Use the folder button to select a log file.

« Do Not Delete Temp Makefiles—Determines whether to delete temporary makefiles when
the build completes (sets ECADDIN DONT RM TMP MAKEFILES=true if enabled).

« Do Not Use Unique Names—Determines whether to use unique names for temporary files
(sets ECADDIN DONT USE_UNIQUE=true if enabled).

. Enable ECBreakpoint—Determines whether to invoke ecbreakpoint in failed jobs.
. Enable ECBreakpoint for Specific Projects—Invokes ecbreakpoint for specified projects.
Use the folder button to select projects and delimit projects with a semicolon.

Using Macros in the Solution Settings String-Based Fields

In any string-based field (such as the path name you enter into the Debug Log Name field) in the
Electric Cloud solution settings, you can use a custom build command instead of a hardcoded string. For
example, you can create a command that generates separate debug logs if you are running separate
builds where each build has a different configuration.

Solution Settings
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Following is an example of a dialog box for entering macros:

P
o Debug Log Name

{0t Dir)

b

.1

Mame

Corfiguration
CorfigurationMame
Devervv Dir
Framework Dir
FrameworcSDKDir
FrameworkVersion
Int Dlir

Platform
PlatformMame
ProjectMame

»

Walue

Debug
Debug
c:\Program Files {<86)"\Microsoft Visual Studio 10.0NCommon ™IL
C Windows \Microsoft. NET Framework*,

C:MProgram Files (86) \Microsoft SDKs \Windows'w 704N

vd.0

S{Corfiguration)®.

&(Solution DirkS{Configuration)®.
Mixed Platforms

Win32

Win32 App

4

]
r.

et | ok ||

:

To edit a set of macros for a field, click in the field, then click the Macros button to invoke the macro
editor for that field, then click the Macros<< button to view the list of available macros.
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Solution Settmgs E__J — - —

i Basic
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History
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Annotation

- Options

| = General

- Advanced
- Command Line

Log Name

Debugging Options
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Environmental Variables Node
File System Parse Qutput File
Profie Parse
History Relocation Data
] 10b Subbuids
] NMake Lexer Emulation/Platform
Ledger

LA [None]

Accept changes

Macros |[ OK

J[ cancel |

« Log Name—Specifies the name of the debug log (sets ——emake-1logfile). Use the folder button
to select a log file.

. Debugging Options—Select the log levels for the eMake debug log file. For details about the
eMake debug log file and log levels, see the “Electric Make Debug Log Levels” section in the
Troubleshooting chapter of the ElectricAccelerator Electric Make User Guide at
http://docs.electric-cloud.com/accelerator_doc/AcceleratorIndex.html.

Advanced Solution Settings

This category contains advanced options.

Solution Settings
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Solution Settings

- General Use Environment
- ElectricInsight Max Cluster Agents
- Options
[=-Debug E
i Converter Registry Root
i Emake
Advanced
- Command Line Max Local Agents

5]

Yield Local Agents

[#] Auto Depend
Visual studio Setup File

Exclude Environment

F5 Behavior

Prompt to switch F5 to Debug Project] | |

Prompt to switch F5 to Debug Project
Do not change F5 behavior

Map F5 to Electric Cloud->Debug Project
Map F5 to Debug->Start Debugging

Changes the default mapping of the F5 key e — | I oK I ’ Cancel

« Use Environment—Determines whether to add /useenv to the devenv call.

« Max Cluster Agents—Specifies the maximum number of agents to use during the build (--
emake-maxagents).

« Registry Root—Specifies the registry root (--emake-reg-roots). You can specify multiple roots
separated by *;’ (a semicolon).

« Monitor—Allows the build to be monitored by ElectricInsight (--emake-monitor).

« Max Local Agents—Sets the maximum number of local agents to use (--emake-
localagents). This field is disabled if eMake version 9.1 or later is installed.

. Yield Local Agents—If using more than n local agents, then eMake releases the number
agents over n every t seconds so they can be used by another eMake that is looking for local
agents (--emake-yield-localagents=N, T). Two values are required in this format: release
agents over this number, every this number of seconds.
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. Auto Depend—Enables or disables allowing eMake to determine dependencies automatically.
Default is enabled.

Note that Auto Depend is now enabled by default in ecdevenv when ecdevenv is invoked from
the Visual Studio command prompt. (When Auto Depend is disabled in the IDE Add-In GUI, this
default is overridden when ecdevenv is called from the GUL.)

For details about Auto Depend (also called eDepend), see the “Dependency Management”
chapter in the ElectricAccelerator Electric Make User Guide at http://docs.electric-
cloud.com/accelerator_doc/AcceleratorIndex.html.

« Visual Studio Setup File—Specifies the Visual Studio setup file for command line builds.
Default is vsvars32.bat.

« Exclude Environment—Specifies a list of environment variables to exclude from eMake (--
emake-exclude-env), separated by *:’ (a colon).

. F5 Behavior—Adjusts the behavior of the r5 key to map it to Electric Cloud > Debug
Project, prompt whether to map it to Electric Cloud > Debug Project when pressed, or map
it to Debug > Start Debugging. As with Debug > Start Debugging, this option uses the
Visual Studio debugging solution setting to determine whether to prompt to build, always build,
or never build before running the debugger.

Debug Project runs the current project (not the startup project as with Debug > Start
Debugging). Electric Cloud > Debug Project is unavailable if zero projects or more than one
project is selected.

Note that you must always use the Visual Studio Debug menu to manage the debugging
session.

Command Line Solution Settings

This category lets you add additional options not explicitly specified elsewhere.

Solution Settings
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= General Additional Options

Annotation Environmental Variables

- Options
=~ ngug

- Advanced 2IETE

¥ Command Line -

Command Line

ecdeveny.exe jbuild fvirtualize fconfiguration="c:\rthomas'src -
Ywepluginimain\ECAddIN'\ECAdIN. sln.ecaddin® foptions="c:
Yrthomas'srciwspluginimain\ECADDIN'\ECAddIn.sln.ecd™ —emake-
emulation=nmake —emake-edger=command —emake-cm=my-
duster-manager —emake-root=.;c:\Source -—-emake-history=merge

Specifies the build label {(—emake-build4abel) [ Mages |[ ok ][ cancel

. Additional Options—Specifies a list of converter options in this format: <Name=value>. These
are the same options specified on Setting VS Converter Environment Variables on page 9-1

« Environmental Variables—Specifies a list of environment variables in this format:
<variable>=<value>, separated by a carriage return. Do not use set.

. EMake Options—Specifies a list of eMake options in this format: --emake-<option>=<value>,
separated by a carriage return.

For Accelerator 9.1 and later versions, you cannot simultaneously use local agents and a cluster
manager. This means that using the --emake-localagents eMake option and the --emake-cm

eMake option produces the following error: ERROR EC1323: —emake-cm and —emake-
localagents cannot both be enabled.

« Command Line—A non-editable field that shows the ecdevenv command that is executed by
the converter. VS Converter options are stored in the /options file.

Help Menu

This dialog box shows the help resources:
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Resources

Community Forum: ask electric-cloud .com

Online Documentation  docs electric-cloud.com

oK

The Community Forum (https://ask.electric-cloud.com/) is where you can find solutions to common

problems, or ask a question. Go to http://docs.electric-cloud.com/ to find documentation for all Electric
Cloud products.

About

This dialog box shows version information about the currently installed IDE add-in or package, the

eMake version and the ElectricInsight version. Refer to these versions where contacting support or
asking questions on the community forum.

(@ Electric Cloud

ElectricAccelerator WS IDE Add-in v5.0.0.0
Electric Make version 8.2, 1.66453 32-bit
Electric Insight v5. 1.0,5899

Copyright {c) 2016 Electric Cloud Inc.

Provides user-space UI integration for calling ElectricAccelerator from -
within the Visual Studio IDE v5.0.0.0

Solution Settings
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Chapter 7: Using the ecdevenv Utility

ecdevenv.exe is a command-line drop-in replacement for devenv.exe that builds Visual Studio solutions

and projects using eMake. Following are the key ecdevenv features:

Skip generation of NMAKE makefiles

No makefiles are required

Visual Studio toolchain virtualization

Ability to build multiple solutions and projects in one command
Ability to specify global converter options in an options file
Forced regeneration of makefiles if required

Ability to generate makefiles without running eMake

The pre-4.0 behavior of ecdevenv is still supported in versions 4.0 and later.

About ecdevenv

No Makefiles are Required

Without ecdevenv, you must create a makefile to build using eMake:

all:

devenv.exe solution.sln /build Debug

Then call this makefile with eMake:

emake.exe —--emake-cm=<your cm> --emake-emulation=nmake -f makefile

With ecdevenv, you can simply use the following command:

ecdevenv.exe solution.sln /build Debug --emake-cm=<your cm>

ecdevenv converts the solution into NMAKE makefiles and runs eMake on them using the eMake
parameters specified. Devenv and eMake arguments can be in any order. ecdevenv automatically uses

NMAKE emulation.

ecdevenv always converts the solution locally, so any differences between the eMake machine and

agent machines can be ignored.

Miscellaneous Files that ecdevenv Generates

ecdevenv creates several files in the build directory. You do not need to check these files in to your
revision control system, unless you want to skip regeneration of NMAKE makefiles.

*.eccache
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"* eccache" files are created in the same directory as the solution files. One file is created for
each invocation of ecdevenv. ecdevenv uses this file to determine whether it needs to
regenerate the temporary makefiles. Delete these only if you want to force ecdevenv to
regenerate makefiles.

e metrics.sln.Release Win32.ecmak andmetrics.vcxproj.Release Win32.ecmak

These are temporary makefiles generated by ecdevenv. Do not delete them unless you are
regenerating the temporary makefiles.

e metrics Release Win32.sln

This is a copy of the original solution used to remove project dependencies. This was generated
by ecdevenv (note the configuration name in the file name) Do not delete it unless you are
regenerating the temporary makefiles.

e metrics.sln, metrics.vcxproj, metrics.vcxproj.filters, metrics.vcxproj.user

These are Visual Studio files. Do not delete them.

e .roots
This contains the list of generated eMake roots. Do not delete it.

You can relocate these files by using the ECADDIN MAKEFILE CACHE environment variable. For details,
see the Relocating Makefiles Generated by the Converter on page 9-10 section in the Setting VS
Converter Environment Variables on page 9-1 chapter.

Virtualizing the Visual Studio Toolchain

Use the /virtualize option to virtualize the Visual Studio toolchain. This virtualizes the Visual Studio
installation directory, SDK directory, and relevant registry entries. This negates the need to install
Visual Studio on the agent machines. Make sure that you have installed the following software before
using this option:

« Relevant .NET version that you are using

« Relevant redistributable for your version of Visual Studio

Building Multiple Solutions and Projects

ecdevenv can build multiple solutions. To use this capability, create a makefile in the following format
and (optionally) specify the projects and project configurations:

<BuildSpecification>
<Solution>

<Name>Solutionl.sln</Name>

<Platform>Mixed Platforms</Platform>

<Configuration>Debug</Configuration>
<Project>
<Name>Projectl\Projectl.vbproj</Name>
<Platform>Any CPU</Platform>
<Configuration>Debug</Configuration>

</Project>

Chapter 7: Using the ecdevenv Utility
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<Project>
<Name>Project2\Project2.vcproj</Name>
<Platform>Win32</Platform>
<Configuration>Debug</Configuration>
</Project>
</Solution>
<Solution>
<Name>Solution2.sln</Name>
<Platform>Mixed Platforms</Platform>
<Configuration>Debug</Configuration>
</Solution>
</BuildSpecification>

Then pass the name of the file to ecdevenv using /configuration=<filename>.

Enabling Debugging Output

» Set ECDEVENV DEBUG=true toturn on debugging (output is sent to stdout by default).

» Set ECDEVENV_DEBUG LOG=<filename>to redirect output to afile.

Using ecdevenv Command Options

Option Description

Specifies the configuration file that allows
multiple solutions and projects to be built. See
the Building Multiple Solutions and Projects on

/configuration=<file>

page 7-2 section above.

/force Forces the regeneration of makefiles.

Generates the NMAKE makefiles without

/generate
running eMake.
/hel Displays a list of ecdevenv options and sample
elp
options and configuration files.
Runs clean locally rather than on the cluster.
/localclean This makes the clean faster and avoids

conflicts in a rebuild.

Enabling Debugging Output
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Option Description

Specifies an alternative default makefile
(rather than ecdevenv.mak).

/makefile

Specifies the converter options. The file uses
/options=<file> the format shown in the Setting VS Converter
Environment Variables on page 9-1 chapter.

Converts the solution to NMAKE more quickly
Jquick by parallelizing down to the project level only.
quic
For details, see the Using Fast Solution

Conversion on page 7-5 section below.

Never regenerates makefiles. You use this

/ki when you have cached makefiles. You must
skip

manually regenerate makefiles using /force

when required.

/use64bit Specifies the 64-bit version of eMake.

/version Displays the ecdevenv version number.

Virtualize the Visual Studio toolchain (off by
/virtualize default). See the Virtualizing the Visual Studio
Toolchain on page 7-2 section above.

Using ecdevenv Environmental Variables

Variable Description

ECDEVENV_DEBUG Turns on debugging to stdout.
ECDEVENV_DEBUG_LOG Redirects the debug output to a specified file.
ECDEVENV_NO_EXPLICIT DEPS Does not use project-to-project dependencies.

Chapter 7: Using the ecdevenv Utility
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Variable Description

Specifies a list of projects to locally build
#pragma runlocal. All project lists are
ECDEVENV RUN LOCAL delimited with semicolons.

See the converter option ECADDIN RUN
LOCAL_ LINK.

Skips checking for devenv.comin the PATH
ECDEVENV_SKIP CHECKS

environment variable.

Skips projects if they have been previously

ECDEVENV_SKIP DUPLICATE PROJECTS o ] }
built in a different solution.

Builds all projects in the solution context. See
ECDEVENV_USE_SOLUTION_ CONTEXT the Debugging a Failed Build on page 13-1
section.

Specifies a list of projects to build in the

solution context. All project lists are delimited
ECDEVENV_USE_SOLUTION CONTEXT with semicolons.
FOR_PROJECTS

See the Debugging a Failed Build on page 13-1
section.

Using Fast Solution Conversion

Use /quick for fast solution conversion. This option converts the solution to NMAKE more quickly by
parallelizing down to the project level only. The option is best suited to solutions containing no C++
projects.

When using the /quick option, you must also specify the full platform and configuration. For example,

ecdevenv solution.sln /build "Release|Win32" /quick

The option is available only with Visual Studio 2005 and newer versions. If you try to use the option
when building a solution in Visual Studio 2002 or Visual Studio 2003, the following error message

appears: Error: /quick can only be used with VS2005 and higher.

Visual Studio does not need to be installed for you to use fast solution conversion. However, MSBuild
must be installed.

Using Fast Solution Conversion
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Supporting Multi-Byte Characters

When building solutions that have multi-byte characters in their pathnames, set the following
environmental variables:

¢ ECADDIN USE INLINE FILES=false

¢ EMAKE MAKEFILE CODEPAGE=65001

Chapter 7: Using the ecdevenv Utility




Chapter 8: Building VS from the Command
Line

ElectricAccelerator can build Visual Studio solutions in two different modes:

« Use ecdevenv as a drop-in replacement for your command-line build (recommended)

« Create a makefile containing the devenv calls

Using ecdevenv

If you choose to use ecdeveny, replace:

devenv.com Solution.sln /build Debug
with:

ecdevenv Solution.sln /build Debug --emake-cm=<yourcm> /virtualize
ecdevenv does the following:

1. Converts Solution.sIln to NMAKE format.

2. Calls eMake on the generated files.

The /virtualize flag virtualizes the Visual Studio toolchain, negating the need to install Visual Studio
on the agents. You must, however, ensure the relevant versions of .NET and redistributables are
installed.

devenv must be in the PATH environment variable before executing ecdevenv.

Creating a Makefile

Before you can use Accelerator to build your Visual Studio project, make sure you have already installed
and run Visual Studio on each agent host for each user (all ECloudInternalUsers).

If you currently invoke Visual Studio from inside a makefile, you are ready. If you invoke Visual Studio
directly from the command line or through a batch file, you must create a makefile for eMake to run.
For example:

all:
devenv /build Release foo.sln

devenv /build Release foo.sln /project bar.vcproj

The makefile must invoke devenv with the options you currently use. Ensure the correct version of
devenv is in your path:

devenv /?
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and ensure that the usual Visual Studio environment variables are set.

For example:
all:

devenv /build Release foo.sln /vsp

Setting the Path for 64-Bit or Xbox Builds

To run 64-bit or Xbox builds, you must set the path manually.

Chapter 8: Building VS from the Co




Chapter 9: Setting VS Converter Environment
Variables

Setting the Converter Variables

You can control the way the VS Converter works by setting these environment variables on the eMake
machine. Alternatively, you can set the variables in a configuration file and set ECADDIN
CONFIGURATION FILE to its full or relative pathname.

all:
set ECADDIN CONFIGURATION FILE=addin.cfg
devenv.com Solution.sln /build Debug

Sample addin.cfg:

<SolutionSettings>
<DisableAddin>false</DisableAddin>
<DoNotParseProjects>false</DoNotParseProjects>
<ECBreakpoint>false</ECBreakpoint>
<DoNotParseSpecificProjects />
<ECBreakpointProjects />
<RunLocalLink />
<UseDevenvForProject />
<EnableDebugLog>false</EnableDebugLog>
<DebugLogName>ecdebug. log</DebugLogName>
<MaxPDBFiles>16</MaxPDBFiles>
<UseOrderOnlyPreregs>true</UseOrderOnlyPrereqgs>
<EnableIncrementallLink>false</EnableIncrementalLink>
<RemoveDependencies>true</RemoveDependencies>
<ForceZ7>true</ForceZ7>
<UpToDateCheck>false</UpToDateCheck>
<DoNotDeleteTempMakefiles>false</DoNotDeleteTempMakefiles>
<DoNotUseUniqueNames>false</DoNotUseUniqueNames>
<ExpandLinkerObjects>false</ExpandLinkerObjects>
<RunDeploymentLocally>false</RunDeploymentLocally>
<RunLocalProject />
<SerializeAllProjects>false</SerializeAllProjects>
<UseDevenv>false</UseDevenv>
<UseMSBuild>true</UseMSBuild>

</SolutionSettings>

All environment variables override variables in the configuration file, so you can set them outside of the
configuration file as needed. The EMAKE configuration file (in $ (InstallDir)\i686

win32\conf\emake.conf) may also override these settings.
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Environment Variable and Description Default

Configuration File Variable

Adds the locations of all inputs (such
as .cpp and .h files) and outputs (such
as .obj, .exe, and .dll files) to the
eMake root automatically.

This variable applies only to C++
projects. For a C# project or a project False

with inputs and outputs not in the (converte
- solution or project locations, you r)
AddEmakeRootsAutomatically must add their locations to the eMake | True
root manually. (ecdevenv
and IDE)

This variable does not apply to third-
party tools, because they cannot be
virtualized. It also does not apply to
project locations and each location for
the solution(s), because they are
always added automatically.

Specifies projects' build order. Use
only if Accelerator is not building =
projects in the correct order.

ECADDIN BUILD ORDER

BuildOrder

Modifies the call to MSBuild to build a
project within the solution context.

This overrides the ECADDIN BUILD
SPECIFIC PROJECTS IN SOLUTION

CONTEXT variable and the
BuildSpecificProjectsInSolutionConte
xt configuration file variable. This
option is needed for unparsed
projects (such as C# projects or
unparsed C++ projects).

ECADDIN BUILD PROJECTS IN SOLUTION

CONTEXT False

BuildProjectsInSolutionContext

Chapter 9: Setting VS Converter Environment Variables
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Description

Default

ECADDIN BUILD SPECIFIC PROJECTS IN
SOLUTION CONTEXT

BuildSpecificProjectsInSolutionConte
xt

Allows a list of projects to be built in
the solution context in MSBuild.
Supply a list of projects (separated by
a semicolon but no spaces). This
option is needed for specific unparsed
projects (such as C# projects or
unparsed C++ projects).

ECADDIN CONFIGURATION FILE

Sets the filename of the configuration
file. Environment variables override
the settings in this file.

ECADDIN CREATE MISSING DEPENDENCIES

Creates missing dependencies to

L . False
CreateMissingDependencies avoid missing dependency warnings.
Setting this variable to any value
causes debug log files to remain in
ECADDIN DEBUG $TMP%\ecdebug<ID>.log on the
agent host. These files are used for False
EnableD L . .
ableDebuglog troubleshooting by Electric Cloud
engineers. Normally, you do not need
to set this value.
Specifies the debug log name.
Requires ECADDIN DEBUG. Use '$1'in
the file specification to insert a unique
ECADDIN DEBUG LOG FILENAME ID. For example,
DebugLogName C:\Users\Bill\ecdebug $1.log. -
Use a file location outside of eMake
root. The log file is stored on the
agent.
ECADDIN DISABLE MINIMAL REBUILDS
Disables minimal rebuilds. False
DisableMinimalRebuilds
ECADDIN DISALLOW BSC Does not generate browse Fal
alse

DisallowBSC

information files.

Setting the Converter Variables
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Environment Variable and

Configuration File Variable

Description

Default

ECADDIN DISALLOW PCH

Does not generate/use precompiled

header files (implied by ECADDIN MAX | False
DisallowPCH
PDB_FILES)
ECADDIN DISALLOW PDB
. Does not generate PDB files. False
DisallowPDB
ECADDIN DISALLOW_ SBR Does not generate browse Fal
alse
DisallowSBR information files from sources.
Prevents the converter from adding
ECADDIN DONT ADD PCH LOCATION the location of the PCH file in all
i cases. This variable is relevant only if False
DoNotAddPCHLocation
ECADDIN MAX PDB_FILES OF ECADDIN
DISALLOW PCH is switched on.
ECADDIN DONT ALLOW PCH AND PDB
Switches off PDB and PCH generation. | False

DoNotAllowPCHANndPDB

ECADDIN DONT PARSE PROJECT

DoNotParseSpecificProjects

Prevents the VS Converter from
breaking up specified C++ projects.
This variable takes a list of project
names separated by semicolons and
without white spaces. This variable is
useful for deploying the converter. If,
for any reason, the converter cannot
build some of your projects, this
variable lets you work around the
problem.

When using this variable, you might
experience an the warning MSB4098.
You can ignore this warning, because
any project references are now
converted into additional
dependencies. MSBuild, however,
does not provide a mechanism to
turn off this warning.

Chapter 9: Setting VS Converter Environment Variables
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Default

ECADDIN DONT PARSE PROJECTS

DoNotParseProjects

This variable takes any non-blank
value and its behavior is similar to
ECADDIN SERIALIZE. It calls devenv
on each project (the converter does
not convert each project into
individual compile/link steps).

ECADDIN DONT RM TMP MAKEFILES

Retains makefiles created during the
build but normally deleted when the

build finishes. This environment False
DoNotDeleteTempMakefiles . s
variable can have any value; it just
needs to be set.
ECADDIN DONT_ RUN TEST only. Convert makefiles without Fal
alse
DoNotRun running eMake.
Disables the converter. This
environment variable can have any
value, it just needs to be set. Also,
you can disable the converter on each
host by using the Visual Studio
ECADDIN DONT USE Converter Manager (on the Tools
False
DisableAddin ER):
Note: This is a lightweight
uninstall program that disables
one individual machine at a
time.
ECADDIN DONT USE_UNIQUE Does not use unique names for
temporary makefiles. Use with False
DoNotUseUniqueNames
ECADDIN DONT RM TMP MAKEFILES.
ECADDIN ECBREAKPOINT Determines whether to invoke .
alse

ECBreakpoint

ecbreakpoint on failed jobs.

ECADDIN ECBREAKPOINT PROJECTS

ECBreakpointProjects

Determines whether to invoke
ecbreakpoint for specified projects.
Use a semicolon to delimit projects.

Setting the Converter Variables
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Environment Variable and

Configuration File Variable

Description

Default

ECADDIN ENABLE INCREMENTAL LINK

Inserts a call to ectouch.exe.. See

EnableIncrementalLink Tuning Performance on page 10-1. True
ECADDIN EXPAND LINKER OBJECTS Expands linker objects to one line per

object. Prevents errors when link line False
ExpandLinkerObjects length is exceeded.

Enables /Z7 compiler options for all

C++ files. Note that enabling this

setting typically creates larger
ECADDIN FORCE_z7 executable or library files. Enabling True
ForceZ?7 this setting adds debugging

information to the object files and

therefore overrides ECADDIN MAX

PDB FILES.
ECADDIN INCLUDE CMAKELISTS Excludes any source file with the

. name CMakelLists.txt. Set this False

IncludeCMakelists variable to True to execute the file.

Adds /Yl<projectname> to the PCH
ECADDIN INJECT PCH REFERENCE creator (/Yc). Set it to false only if T

InjectPCHReference

linker tools error LNK2005 (multiply-
defined symbol error) appears.

ECADDIN LINK PARAMETERS

LinkParameters

Adds options to the linker command.
You can specify one or more options

separated by spaces. For example,
ECADDIN LINK

PARAMETERS=/0PT :REF Or
LinkParameters=/INCREMENTAL

/NOLOGO /DEBUG /PDB:a.pdb.

ECADDIN MAKEFILE CACHE

MakefileCache

Path to an alternate location for the
cached (temporary) makefiles that
are generated by the converter. For
details, see the Relocating Makefiles
Generated by the Converter on page
9-10 section below.

Chapter 9: Setting VS Converter Environment Variables
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Description

Default

ECADDIN MAX PDB FILES

MaxPDBFiles

Specifies the maximum number of
PDB files to produce. This setting has
no effect if you set ECADDIN FORCE
z7=true, which adds debugging
information to the object files. For
details, see Optimizing Parallelization
Using PDB Splitting on page 10-3.

16

ECADDIN MSBUILD DIR

MSBuildDir

Path to the location of msbuild.exe if
different from the default.

ECADDIN MSBUILD PARAMETERS

MSBuildParameters

Adds extra parameters to msbuild
command line.

ECADDIN NOLINK

NoLink

Performs all build steps except linking
and post build steps. When this
variable is enabled, Visual Studio
displays the following message at

build time: Warning: Not linking
because ECADDIN NOLINK is set."

False

ECADDIN PARSE BUILD CUSTOMIZATIONS

ParseBuildCustomizations

Recognizes Visual Studio build
customizations. If you encounter
issues with a project when using this
feature, you can disable it for all
projects containing Build
Customizations by setting it to FALSE
or by disabling parsing for only that
project by setting ECADDIN DONT
PARSE PROJECT Or
DoNotParseSpecificProjects to TRUE.

True

Setting the Converter Variables
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Environment Variable and

Configuration File Variable

Description

Default

ECADDIN NORECURSE

Builds only the specified project
configurations while ignoring
dependent projects in those
configurations. When used in

conjunction with /clean, this cleans False
NoRecurse o ) .

only the specified configurations.

When used in conjunction with

/Rebuild, this rebuilds only the

specified configurations.
ECADDIN REMOVE DEPENDENCIES Removes project-to-project

dependencies to improve False
RemoveDependencies N

parallelization.
ECADDIN RUN DEPLOYMENT PROJECTS )
LOCALLY Runs deployment projects locally Eal

alse

RunDeploymentLocally

using #pragma runlocal.

ECADDIN RUN LOCAL LINK

RunLocallLink

A list of projects where the linker will
be run locally (using #pragma

runlocal).

ECADDIN RUN LOCAL PROJECT

RunLocalProject

Use this variable if your build uses a
local resource (for example, a
resource only on the eMake host (for
example, a database). You do not
need to set this variable if your
project build includes web
deployment; this is handled by the
converter. The value of this variable is
a list of project names separated by
semicolons. Each project name must
be the unique Visual Studio identifier
for the project (for example,
solutionl/projectl.vcproj). Do
not add quotation marks or white
spaces.

Chapter 9: Setting VS Converter Environment Variables
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Default

EADDIN SERIALIZE

Causes each project to be built
serially. It inserts ‘#pragma

allserial’ into each makefile. This False
SerializeAllProjects variable is equivalent to setting

ECADDIN DONT PARSE PROJECTS.

Pre-parses the projects to determine
SUADDUL L WO Dl CA whether there is anything to build. True
UpToDatecheck Prevents unnecessary rebuilding of

static build steps.
ECADDIN_USE_DEVENV Uses devenv (rather than msbuild) Ealse
UseDevenv for all unparsed projects.

Uses devenv (rather than msbuild) to
ECADDIN_USE_DEVENV_FOR_PROJECT build specific projects. Supply a list of
UseDevenvForProject projects (separated by a semicolon) -

to be built with devenv.

Use this variable to workaround a
ECADDIN USE LEGACY CODE Visual Studio bug where e
UselLegacyCode AdditionalLibraryDirectories does not

give the correct value.
DCRADDIN JSL MESTLLD Uses msbuild internally for projects True
UseMSBuild that the converter cannot parse.

(Visual Studio 2010 and newer

versions) Uses msbuild internally for True (VS

linking. These variables are a 2015+)
ECADDIN_USE_MSBUILD_FOR_LINK workaround for an issue in which
UseMSBuildForLink VCManifestTool is not supported in False (VS

Visual Studio 2015 and newer 2010-

2013)

versions and might not be supported
in Visual Studio 2010-2013.

Setting the Converter Variables
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Environment Variable and

Configuration File Variable

Description

Default

ECADDIN USE ORDER ONLY PREREQS

Uses order-only prerequisites
(available in Accelerator v7.0 and

UseWCEMacros

True

UseOrderOnlyPreReqs later). This allows for quicker first

time (no history) builds.

Uses relative paths in the makefile to
ECADDIN_USE_RELATIVE_PATHS reduce line lengths and to allow the
UseRelativePaths build location to be changed without

regenerating makefiles.
ECADDIN USE WCE MACROS

Loads platform macros. False

ECADDIN XBOX INSTALL DIR

XBoxInstallDir

Path to the location of Xbox SDK if
different from the default.

ECADDIN XBOX VERSION

XBoxVersion

Xbox SDK version if different from the
default.

Relocating Makefiles Generated by the Converter

Generated (temporary) makefiles include .ecmak files, solutions and projects, RC files, and up-to-date
check files. By default, these files are in the same location as their corresponding solution or project. For
example:

e C:\Test\solution 00l\solution 00l.slngeneratescC:\Test\solution 001l\solution
001.sln.ecmak

e C:\Test\solution 00l\projectl\projectl.vcxproj generatesC:\Test\solution
001\projectl\projectl.vcxproj.ecmak

You can specify a path to an alternate location for these files by setting the ECADDIN MAKEFILE CACHE
environment variable. For example, if you enter set ECADDIN MAKEFILE CACHE=C:\temp, then

e C:\Test\solution 00l\solution 00l.slngeneratescC:\temp\solution 001.sln.ecmak

e C:\Test\solution 00l\projectl\projectl.vcxproj generates
C:\temp\projectl\projectl.vcxproj.ecmak

(Note that the makefiles are relative to the solution directory.) This variable is useful when you want to
keep eMake-generated files out of the source tree or when the source tree is read-only.

Chapter 9: Setting VS Converter Environment Variab
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Setting the Environment Variable to Enable Local
Solution Builds

You can build a solution locally with eMake but without using remote agents or local agents. You might
want to use this function if a distributed incremental build is slow, or if a local Visual Studio incremental
build causes unnecessary rebuilding of objects. To make this function visible in the Electric Cloud
menu, set the environment variable ECUIADDIN LOCAL BUILD=true. For more information about this
menu, see the Main Menu and Toolbar on page 6-2 section.

Setting the Environment Variable for ecdevenv
Startup Checks

By default, the ecdevenv utility perform several checks (such as the existence and proper version
number of the converter) when it starts. To disable the checks, set the environment variable
ECDEVENV_SKIP CHECKS=true.

ment Variable to Enable Local Solution Builds






Chapter 10: Tuning Performance

The converter has several methods for improving performance. To determine which is best for your
situation, generate an annotation file and open it in ElectricInsight.

To generate an annotation file, pass --emake-annodetail=basic, file, lookup, env to your eMake call.
By default, the annotation file is named emake . xml.

Available methods:

« Improving Build Time for /Zi + PCH Builds on page 10-1

« Improving Build Time for Solutions with Many Projects on page 10-1
« Improving Final Link Time on page 10-2

« Improving Incremental Build Time on page 10-2

« Improving Incremental Linking Time on page 10-2

« Optimizing Parallelization Using PDB Splitting on page 10-3

Improving Build Time for /Zi + PCH Builds

The default configuration for VC++ projects is /Zi and using PCH. To parallelize this combination, the
converter splits PDB and duplicates PCH. However PCH files are usually very large and might negate any
improvement parallelization offers.

To improve build time in these circumstances:
1. SetECADDIN FORCE ZzZ7=true.

This is the single most effective way to improve build speed. Enabling this setting does not create
PDB files and thus overrides ECADDIN MAX PDB_FILES.

2. Set ECADDIN DISALLOW PCH.
This turns off PCH but might result in build failures that can be fixed in code only.
3. Reduce ECADDIN MAX PDB FILES.

Reducing this setting reduces parallelism but decreases the time spent copying PCH files. (This
setting has no effect if you set ECADDIN FORCE_z7=true, Which does not create PDB files.)

Improving Build Time for Solutions with Many
Projects

Some very large solutions with few interproject dependencies might benefit from not parsing the
project down to the project item level. Follow these steps:

1. Set ECADDIN DONT PARSE PROJECTS=true.

2. Clear history.
3. Rebuild.
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Although you lose find-grain parallelism, the reduced overhead might reduce the overall build time.

Improving Final Link Time

Many typical solutions have a final link (or lib) that is very large and slow on the cluster. To perform this
link locally, set ECADDIN RUN LOCAL LINK=<project>.

Improving Incremental Build Time

By default, the converter does not rebuild prebuild events. Instead, the converter first checks whether
thereis anything out of date. If not, nothing will be built, including the prebuild event.

To always rebuild prebuild events, set ECADDIN UP TO DATE CHECK=false.Note that when you set this
environment variable to false, if you have a prebuild event that touches files, it could potentially
rebuild far more than Visual Studio would.

Improving Incremental Linking Time

Improving Incremental Linking Time with the Converter

Visual Studio supports incremental linking with the /INCREMENTAL linker option. This does not function
in eMake, because eMake updates the time stamp of the exe/dIl when it copies it back to the build
machine (from the agent) to prevent any problems because of clock skew.

To work around this problem, the converter “touches” the exe after the link with its current time
stamp. This explicit modification of the time stamp instructs eMake to preserve the time stamp, which
keeps the validity of its incremental status. The converter inserts a call to ectouch.exe, which performs
the action stated above. ectouch.exe must be in $PATHS.

To disable this feature with the converter, set ECADDIN ENABLE INCREMENTAL LINK=false.

Improving Incremental Linking Time without the Converter

If you are not using the converter, you can still use this feature. You can rename ectouch.exe to
eclink.exe and replace occurrences of link.exe with eclink.exe.eclink.exe should bein $PATHS.
Alternatively, you can rename link.exe to link_ec.exe and copy eclink.exe to link.exe. (If you
want something other than 1ink ec.exe,set EC ORIGINAL LINK PATH to the location of the “real”

link.exe.)

0000000000000
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Optimizing Parallelization Using PDB Splitting
Optimizing Parallelization with the Converter

By default, Visual Studio puts all debugging information in a centralized database (PDB) called vc80.pdb
(this is Visual Studio version-specific). Because each compilation modifies this file, everything in the
project is serialized. A workaround is to group debug information into multiple PDB files. You can
accomplish this automatically if you use the converter.

ECADDIN MAX PDB FILES is set to 16 by default. You can change this value to be equal to or less than
the number of agents, but you might need to increase or decrease this for optimal efficiency. ECADDIN
MAX PDB_FILES specifies the maximum number of PDB files produced. Each file is placed into a PDB
determined by a hash of its filename. This method ensures that a particular file is always placed in the
same PDB. This is necessary to ensure eMake's history file remains valid.

For example, if a project contains 4 files, Filel.cpp, File2.cpp, and so on, and they are all serialized
on PDB file vc80.pdb. Set ECADDIN MAX PDB FILES=2 will create (at most) 2 PDB files:

Filel.cpp --' <ProjectName>_0.pdb
File2.cpp --' <ProjectName>_1.pdb
File3.cpp --' <ProjectName>_0.pdb
File4.cpp --' <ProjectName>_1.pdb

In this example, Filel and File3 will be serialized against each other but will build in parallel from File2
and File4 (which will be serialized against each other).

You can change this variable in the Visual Studio IDE Converter solution settings. Go to the
Performance section of the Converter pane.

The history file must be deleted when adding or changing the value of ECADDIN MAX PDB_FILES. You
can also set --emake-history=create.

Optimizing Parallelization without the Converter

This technique can be used without using the converter. This distribution contains the application
hashstr.exe, which hashes the filename and returns the bucket number. You can use this in your
makefile to set the PDB filename (using /fd) in the same manner as above. Precompiled headers must
be switched off for this to work.

Usage: hashstr "mystring" [modulus]

Where mystring is the string from which to generate the hash value, and modulus is the number of
hash bins you want to use.

You can add this to a pattern rule for builds that suffer from performance degradation due to PDB
serialization, with something similar to the following:

%.0: %.C

Optimizing Parallelization Using PDB Splitting




1 0 - 4 ElectricAccelerator Visual Studio

$(CC) /c $(cflags) $(PCH USE FLAGS) $(cvars) $(cplus flags) $(LOCAL INCLUDE)
$ (PCB_INCLUDE) $< /Fo$@ /Fd$ (shell ${path-to-hashstr}/hashstr.exe "$@"
${hashstr-modulus}) .pdb

Troubleshooting

ElectricInsight lets you pinpoint performance problems or conflicts in a parallel build. Until now, there
has been little visibility into builds to “see” why a build was slow, why a build broke, or which
dependencies were involved. ElectricInsight® (Insight) removes the “black box” around software
product builds and provides easy-to-understand performance data.

Chapter 10: Tuning Performance




Chapter 11: Using MSBuild

Building MSBuild Projects in Parallel

ElectricAccelerator cannot parallelize MSBuild project files. If you have multiple MSBuild projects,
however, you can create a makefile to build them in parallel.

For example:

all: projectl project2

projectl
msbuild myproject.csproj /t:build

project2:
msbuild myproject.csproj /t:build

Then run:

emake —-f makefile —-emake-emulation=nmake --emake-cm<your cm>
For C++ projects, call devenv (or ecdevenv) to parallelize those projects down to the project item level.

If you use a top-level MSBuild script that builds separate projects, convert that to NMAKE in the format
above to achieve parallelization under eMake.

Using MSBuild to Build a Project Directly in Its

Solution Context

When set to true, the ECADDIN USE_SOLUTION IN MSBUILD environment variable lets you use MSBuild
to build a project directly, but in the context of its solution, by generating an appropriate call to be sent
to MSBuild. For example, when you build a C# project named WindowsApplication2 with project
configuration Debug|AnyCPU, the generated makefile contains the following call to MSBuild:

"msbuild.exe" "WindowsApplication2.csproj" /t:build
/p:Configuration="Debug",Platform="AnyCPU"

(Note that MSBuild expects there to be no space between Any and CcpU.)

When you set the environment variable to true, the command is changed to build the
WindowsApplication2 project in solution configuration Debug|Mixed Platforms:

"msbuild.exe" "solution 0012.sln" /t:WindowsApplication2
/p:Configuration="Debug",Platform="Mixed Platforms"







Chapter 12: Uninstalling the Visual Studio
Integration

An uninstallation removes all VSP components from a machine. This includes the converters and the
ecdevenv.exe utility from the prior installation. To uninstall the software, follow the procedures described
in the following topics.

Uninstalling the Visual Studio Integration on
Windows

The uninstaller removes all Visual Studio Integration components from a machine at the same time.

Using the GUI

1. Go tothe Electric Cloud installation folder.
2. Run the uninstaller one of these ways:
« Enteruninstall-vsaddin.exe.

« Invoke the uninstaller by using the "Add or Remove Programs" or "Programs and
Features" utilities in the Windows Control Panel. The following prompt appears:

ﬂumnstall ElectricAccelerator V5 Integration - - =HC

6 This will completely remove ElectricAccelerator VS Integration from your system. Are you sure you want to do this?

s

| Yes 1| No
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3. Click Yes.

The "Uninstall Complete" dialog box appears when the uninstallation is complete:

2 ElectricAccelerator VS Iniegration Setup.  » _[isl- e

Uninstall Complete

ElectricAccelerator VS Integration
has been removed from your system.

Finish

Using the Command Line

You can also run the uninstaller in silent mode from the command line.

1. Open a command prompt.

2. Entercd <Electric Cloud installation folder>to go tothe Electric Cloud installation
folder, where <Electric Cloud installation folder> isthe installation folder.

3. Enteruninstall-vsaddin.exe /mode silent.

Chapter 12: Uninstalling the Visual Studio In




Chapter 13: Debugging a Failed Build

Perform the following tasks first when debugging a failed build:

« Double-check that the build works under Visual Studio.

« Seethe Troubleshooting Problems on page 14-1 chapter or ask.electric-cloud.com.
If the previous tasks do not help you debug your build, do the following steps:

1. SetECADDIN DEBUG=true and ECADDIN DEBUG LOG FILENAME=<filename>.

2. Rerun the build.

The <filename> will exist on the machine that performed the conversion. When using
ecdeveny, this will be the local machine. When running devenv or ecdevenv remotely, the file

will exist on the remote machine.
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Chapter 14: Troubleshooting Problems

Initializing Visual Studio

If you do not virtualize the toolchain and did not initialize Visual Studio on every agent host for each

ECloudInternalUser during installation, you must do the initializations manually. Each Accelerator

agent runs as user ECloudInternalUserl, ECloudInternalUser2, and so on.

On each agent host:

A U A W N =

Loginto the user account.

Run Visual Studio.

Choose Tools > Options and browse to Project and Solutions > Build and Run.
Set the maximum number of parallel project buildsto 1.

Choose Help > Customer Feedback Options.

Initialize the Customer Experience Improvement Program to either Yes or No.

If you still encounter issues, go to the Electric Cloud ElectricAccelerator Knowledge Base and search for

“Visual Studio.” Also refer to ask.electric-cloud.com for answers to common issues with eMake and the
Visual Studio Integration.

Common Issues

Check this list of common issues after you verify that Visual Studio initialized properly:

Visual Studio is missing the Electric Cloud menu on page 14-2

Application Data folder could not be created. make: *** [all] on page 14-2

For VS2005 SP1 builds, the build is not broken up and runs as one large job on page 14-3
Build terminated with “not making progress” error on page 14-3

Visual Studio quits immediately at the start of the build on page 14-3

Error “'devenv’ not found” is displayed on page 14-3

Error “Unable to build specified project” or missing file errors on page 14-3

Error *msbuild not found” on page 14-4

Missing DLL errors or Visual Studio installation is corrupt on page 14-4

Error “command line too long” on page 14-4

The build is slow (not parallelized) and/or each line of the build output is prefixed with 1>, 2>,
etc on page 14-4

Error: ‘|’ not recognized on page 14-4

When virtualizing the Visual Studio toolchain, regsvr32 fails trying to register a DLL that uses
debug CRT DLLs on page 14-5

Particular projects do not build under eMake on page 14-5

Electric Cloud menu in Visual Studio is grayed out (disabled) on page 14-5



https://electriccloud.zendesk.com/forums/70688-Accelerator-KB
http://ask.electric-cloud.com/
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« Using Visual Studio 2010, a project fails at link when using the add-in but succeeds when using
Visual Studio alone on page 14-5

« Upgrading only cluster agents to Accelerator v7.0 might cause an error on page 14-6

Visual Studio is missing the Electric Cloud menu
Description

The VS IDE Converter is installed, but the Electric Cloud menu is missing and the Tools menu item is
corrupted (shows "Electric Cloud").

The converter might throw an exception similar to the following:

3:Error: Adding Build menu item: Could not load file or assembly 'stdole,
Version=7.0.3300.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a' or one of its
dependencies. The system cannot find the file specified.

Cause
This occurs because the converter requires stdole.dll to be installed and registered.

Solution

1. Close all instances of Visual Studio.
2. Uninstall the converter from Control Panel.

3. Open a command prompt and register the DLL manually (Adjust the path to gacutil.exe
accordingly.):

"%$PROGRAM FILES%\Microsoft SDKs\Windows\v7.0A\Bin\gacutil.exe" -i ""%PROGRAM
FILES%\Common Files\Microsoft Shared\MSEnv\PublicAssemblies\stdole.dll"

Run Visual Studio and check if the Electric Cloud menu is present.

4. If Step 3 doesn't work, install the Office 2003 Update: Redistributable Primary Interop
Assemblies from
http://www.microsoft.com/download/en/details.aspx?DisplayLang=en&id=20923.

5. Run:

devenv.exe /ResetSettings
This resets the menus.

6. Re-install the converter and run Visual Studio.

Application Data folder could not be created. make: *** [all]

Cause

The current user does not have an account on the agent that is running devenv.exe.
Solution

Do one of the following:

« Use one of the solutions described in the "What does it mean when Visual Studio reports "The
Application Data folder for Visual Studio could not be created"?” Ask article at

Chapter 14: Troubleshooting Problems
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https://ask.electric-cloud.com/questions/707/what-does-it-mean-when-visual-studio-reports-
the-a.html.

« Use ecdevenv locally (so that devenv.exe does not need to run on the agent).

For VS2005 SP1 builds, the build is not broken up and runs as
one large job

Cause

The hotfix for VS2005 SP1 is not installed.

Solution

See http://ask.electric-cloud.com/questions/439/visual-studio-2005-behaves-as-if-the-visual-studio-

add-in-is-not-installed.
Build terminated with “not making progress” error

Cause

There are many reasons for this error. It usually occurs when a build has shown a modal dialog box
(that is not visible to the build user) and is waiting for input.

Solution
See http://ask.electric-cloud.com/questions/427/why-does-visual-studio-stall-and-display-a-modal-
dialog.
Visual Studio quits immediately at the start of the build
Cause
You are running the wrong version of Visual Studio for your build.
Solution

Ensure the environment is setup for the version of Visual Studio you are using.

Error “'devenv’ not found” is displayed
Cause
Visual Studio is not installed on the agent or is not in the same location as the build machine.
Solution

Install Visual Studio on the agent or set the PATH environment variable to reflect the installation
directory on the agent.

Error “Unable to build specified project” or missing file errors

Cause

The missing project or files are not in the eMake root.

Common Issues
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Solution

Make sure all files are either present on the agent, or in the emake root.

Error “msbuild not found”
Cause
.NET is not installed on the agent.
Solution

Install the relevant version of .NET on all agents.

Missing DLL errors or Visual Studio installation is corrupt
Cause
C++ redistributable is not installed on the agent.
Solution

Install the relevant redistributable for the version of Visual Studio you're using on the agents.

Error “command line too long”
Cause
The converter has generated a command line that is too long.
Solution

If the error occurs during linking, set ECADDIN EXPAND LINKER OBJECTS=true, otherwise set ECADDIN
USE_RELATIVE PATHS=true in your environment.

The build is slow (not parallelized) and/or each line of the
build output is prefixed with 1>, 2>, etc
Cause
The build is not using the converter. The 1>, 2> is an indication that devenv is being used.
Solution

Check that the VS Converter is installed on the agents or build machine. (Go to Tools > Add In
Manager.)

For VS2005 SP1, check if the hotfix is installed (see above).

Check for other third-party converters on the agents. The VS Converter might not be compatible with
other build-related converters.

Error: ‘|’ not recognized
Cause

You are using an older Accelerator version (pre 7.0) that doesn't recognize order-only prerequisites.

Chapter 14: Troubleshooting Problems
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Solution

Turn off ECADDIN USE_ORDER ONLY PREREQS.

When virtualizing the Visual Studio toolchain, regsvr32 fails
trying to register a DLL that uses debug CRT DLLs

Cause

These SxS DLLs cannot be virtualized and are not part of the Visual Studio redistribution.
Solution

Do one of the following:

« See http://msdn.microsoft.com/en-us/library/aa985618(v=VS.90).aspx

« Copy debug DLLs from <VSINSTALLDIR>\VC\redist\Debug NonRedist to the target directory
(the location of the DLL that is being registered)

« Copy Microsoft.VC90.DebugCRT.manifest andmsvcr90d.dll from
<VSINSTALLDIR>\VC\redist\Debug NonRedist\x86\Microsoft.VC90.DebugCRT

Particular projects do not build under eMake
Solution
Use ECADDIN DONT PARSE PROJECT to specify the offending projects. Use either the project name or
the project path as shown in the solution file.

Electric Cloud menu in Visual Studio is grayed out (disabled)

Cause

This might occur if you install Visual Studio after installing the converter. Visual Studio’s setup routine
has not initialized the converter.

Also, the debug log will contain: AddCommandControls failed for Build: The parameter is
incorrect. (Exception from HRESULT: 0x80070057 (E_INVALIDARG))

Solution

Open a Visual Studio 2010 or later command prompt as administrator and type:

devenv /setup
Using Visual Studio 2010, a project fails at link when using the
add-in but succeeds when using Visual Studio alone
Description

You encounter this error: LINK : fatal error LNK1123: failure during conversion to COFF: file invalid or
corrupt

Solution

Upgrade Visual Studio to 2010 SP1.

Common Issues
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Upgrading only cluster agents to Accelerator v7.0 might cause
an error

Cause

When upgrading the cluster agents only to Accelerator v7.0, be advised that an older eMake client will
run the same version of eMake on the agent (if it is available). This might result in the following error:

NMAKE : fatal error U1073: don't know how to make'|'
Solution
Do one of the following:

« Upgrade the local eMake client to 7.0 or later (recommended).

o Set ECADDIN USE ORDER ONLY PREREQS=false inyourenvironment.

Chapter 14: Troubleshooting Problems
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